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 how to use RightFax to send and 
and SMS messages, see the user help 
tFax Lotus Notes Module.

ssages of type “Document” (for Certified 
ipient have an SMTP e-mail address, and 

of type “SMS” requires that the recipient 
ther of these may be picked from the 
 Personal Address Book. If the required 

e user will not appear in the address of the 
ialog box has been closed.

ns
ions for integrating faxing with RightFax 
uctions for each of these options are 
er.

ith a full integration, the RightFax setup 
forms, and agents to the Notes mail 
tFax template. Notes users can then use 
own as the RightFax advanced form, to 

he Domino server composes outgoing 
g and incoming faxes in each user's 
htFax also stores outgoing and 
 database. A full integration also adds a 
 User Options to each user's mail 
Chapter

er 1

erstanding the RightFax Lotus Notes Module

ote  The RightFax Lotus Notes Module Guide augments the admin and 
ser help that accompanies the RightFax Lotus Notes Module. For 

nformation on topics not found in this guide, see the admin and user 
elp. Shortcuts to admin and user help are created during the Notes 

nstall and are located on the Notes workspace.

he RightFax Lotus Notes Module provides inbound and outbound 
axing via RightFax directly from the Notes or iNotes clients. The 
ightFax Lotus Notes E-mail Gateway and a Notes client are 

nstalled on the RightFax server. Using the Notes client, the 
ateway logs on to the Domino server, routes incoming faxes as 
emos to Notes client mailboxes, and picks up fax-bound memos 

nd delivers them to the RightFax server for conversion to fax 
ormat and transmission.

ending a Notes mail message to a fax number, email address, or 
obile device as an SMS message is similar to sending mail, 
xcept that the message is specially addressed.

he RightFax Lotus Notes Module installs several RightFax-specific 
atabase files on the Domino server. One of these files 
RFAXSYNC.NSF or “EFM Sync”) can be synchronized with the 
ightFax, thus allowing for configuration and administration of 
ightFax from your Notes server or your RightFax server.

sers can compose faxes while disconnected from the Domino 
erver (for example, using a laptop) and also have many other 
ptions, including previewing a fax before sending and forwarding 
 fax that was sent to them.

For detailed information on
receive faxes, documents, 
that accompanies the Righ

Note  Sending RightFax me
Delivery) requires that the rec
sending RightFax messages 
have a cell phone number. Ei
Domino Directory or from the
information is not present, th
memo once the Addressing d

Notes Integration Optio
You have the following opt
in your Notes system. Instr
provided later in this chapt

z Full Mail Integration  W
adds RightFax forms, sub
template to create a Righ
this template, which is kn
send a fax from Notes. T
faxes and stores outgoin
Notes mail database. Rig
incoming faxes in its own
special document named
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 fax factory
al Notes Mail integration, RightFax will install 

base to improve the efficiency of the Domino 
x composition tasks to the user’s computer. A 

tabase is installed on each client computer, and 
y template database is installed on the Domino 

 factory database is kept up to date by inheriting 
 fax factory template. This permits the fax 
date the user’s fax factory when needed, rather 
il template.

and fax preferences are stored in the User 
 in the EFM Sync database. When a user opens 

ptions document in his Notes mail database, 
pulled into the document from the EFM Sync 
r Options document is stored in the mail 
a stored form so that modifications to the 
re not required. When the user saves changes, 
 in both the EFM Sync database and the local 
e.

s a fax by activating an agent stored in his mail 
nt directs composition of the document to the 
tabase. When saved or sent, the fax is stored in 
base. 

ments are delivered via standard Domino mail 
 database specified in the fax foreign domain 
dering and delivery out of the Domino 
ndled by the gateway service on the RightFax 
omino server resources for Lotus Notes and 

ents are processed by the Lotus Notes module 
rver and stored in the RightFax Mail Router 
e passed from the RightFax Mail Router 
database. Users can edit their copies of this document to 
configure their personal fax settings.

z Minimal Mail Integration With a minimal integration, fax 
composition occurs in a fax factory database that is installed 
locally on the user's computer. To send a fax, users use a basic 
RightFax form. The fax factory then composes the fax. As in the 
full integration, outgoing and incoming faxes are stored in the 
user's mail database and the RightFax database. The minimal 
integration setup adds the following new components to the 
user's mail database: An agent (Actions>Fax Tools>New 
RightFax Document, Fax, and SMS), an agent (Actions>Fax 
Tools> Real-time Fax Status), one shared folder (RightFax 
Settings), and RightFax User Options document (located in the 
RightFax settings folder). For more information about a minimal 
mail integration, see “Understanding the fax factory”.

z No Mail Integration No mail integration allows users to send 
memos as faxes with the standard Notes Memo form and 
RightFax embedded codes (which users type into the body of the 
memo). The no-mail integration locally stores the Notes 
databases required by the RightFax module. Faxes are moved to 
the Domino server by means of foreign domains referenced in the 
manual addressing of the faxes. The RightFax databases are on 
the Domino server and handle the routing of the faxes sent to 
them by means of the foreign domain routing. It makes no 
modifications to any Notes mail template or any users' mail 
databases. Fax documents are stored both in the RightFax 
database and in the user's Notes mail database.

z iNotes Integration The RightFax Lotus Notes Module supports 
Lotus iNotes (also called Domino Web Access) in a minimal-mail 
integration. This allows for fax usage via a web browser, including 
the ability to send and view faxes, and set advanced fax 
attributes.

Understanding the
If you choose minim
the fax factory data
server by moving fa
local fax factory da
a central fax factor
server.

The user's local fax
its design from the
administrator to up
than the Notes ma

User-specific data 
Options document
his personal User O
the current data is 
database. The Use
database and has 
database design a
the data is updated
fax factory databas

The user compose
database. The age
local fax factory da
the user's mail data

Outbound fax docu
mechanisms to the
document. Fax ren
environment are ha
server. This frees D
Domino tasks.

Inbound fax docum
on the RightFax se
database. Faxes ar
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Chapter

atabase to the Domino router task for standard Notes mail 
elivery. Because delivery is the only task handled by the Domino 
erver, fax traffic only impacts the Domino mail router task.

� � �
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s Module, you must have licensed a 
es this module, or purchased and 
ately. For information on activating new 
ax server, refer to the RightFax 

s

.5, R7, or R8. Captaris recommends that 
RightFax server be located on separate 

 R8 clients, one of which must installed 
e e-mail gateway server.

us Notes module in a clustered Domino 
 that faxes that are sent during a failover 
ll the RightFax gateway are confined the 
node (i.e., used by the Notes clients). 
install the RightFax Gateway is returned 
ill be processed according to your 
cument configuration. For instructions 
nections document, see Domino 
er 2

alling the Lotus Notes Module

o install and integrate RightFax with your Lotus Notes system, you 
eed to complete the following basic steps:

. Install the RightFax server (described in the RightFax 
Installation Guide).

. Activate the RightFax Lotus Notes Module (described on 
page 9).

. Choose the type of integration you want for your RightFax and 
Notes system (described on page 5).

. Configure the Notes E-mail Gateway and RightFax Server 
(described on page 11).

. Use the installer database to install the database files for your 
RightFax integration (described on page 11). A manual 
installation, if required is documted (page 13).

. Configure the EFM Sync Database (described in Chapter 3, 
“Configuring the EFM Sync Database”).

ting the Lotus Notes Module
he files required by the RightFax Lotus Notes Module are installed 
n all RightFax servers during the server installation, however, to 
stablish functionality, the Lotus Notes Module must first be 

icensed and activated.

To activate the Lotus Note
RightFax server that includ
licensed this module separ
components on the RightF
Installation Guide.

New Install Requirement
z RightFax 9.4

z Lotus Domino server R6
your Domino server and 
computers. 

z Lotus Notes R6.5, R7, or
on the RightFax or remot

If you are running the Lot
server environment, note
of the node used to insta
MAIL.BOX of the active 
When the node used to 
to service, those faxes w
Domino Connections do
on configuring your Con
documentation .
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e Requirements 
 language setting defines a regional dialect e.g., 
r French (France). Before installing the RightFax 
 must verify the content language setting of the 
an to install RightFax with, is configured to use a 
d by RightFax (shown below). For more 
he Notes content language setting, see Lotus 

nguages supported by RightFax

 
tates) 
 

ny) 

zil) 
) 

ns and Domino Language Packs  
 plans to implement a full mail integration and 
 hosting the RightFax database files has 4 or 
ks installed, you cannot build an optional full 
 5 of the RightFax install) and instead must 
ection using the Full integration profile shipped 
more information about creating new 
ightFax integration options, see the RightFax 
le on the Notes workspace.
Upgrade Requirements 
z RightFax 9.0 or 9.3 with a functional Notes integration

z Lotus Notes R6.5 with any RightFax mail integration

z Lotus Notes R7 with RightFax 'no-mail' integration only

Lotus Requirements
The person performing the install and Notes configuration must 
have the following access rights:

z Designer in the ACL of the mail template to be modified.

z Editor in the ACL of the NAB.

z Ability to create both new and replica databases on the Domino 
server connecting to the module client.

z Ability to create and modify Group documents in the NAB.

z Ability to create and modify a fax foreign domain document in the 
NAB.

z Ability to run unrestricted Lotus Script and Java agents on the 
Domino server that will host the module databases.

z Manager access to all mail database files of all imported iNotes 
users.

Each fax user must have:

z Author access in the ACL of the RightFax EFM Sync database 
on the Domino server.

z Ability to connect to the Domino server EFM Sync.

z Manager access in the ACL of their mail database. iNotes users 
must have a minimum of Editor access and the ability to run 
unrestricted Lotus Script and Java agents on the host Domino 
server.

Regional Languag
The Notes content
French (Canada) o
database files, you
Notes client you pl
language supporte
information about t
Notes help.

Notes content la

z Chinese (China)
z English (United S
z French (Canada)
z French (France) 
z German (Germa
z Italian (Italy) 
z Japanese 
z Portuguese (Bra
z Spanish (Mexico

Full Mail Integratio
If your organization
the Domino server
more language pac
mail template (step
create a new conn
with RightFax. For 
connections and R
Admin help, availab
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 e-mail gateway, a new service called the 
dule is created. This service is set to 
topped by the RightFax Server service. You 
ax E-mail Gateway Module service in 

base Files
d have not already done so, back up the 
ghtFax database files. The default 
no server at \Domino\Data\RightFax.

d logon with the Notes ID used to 
teway.

lick the File menu and choose 
clients use File > Application > Open).  
 to locate the \RightFax\Gateway folder. 
INSTALL.NSF. The About RightFax 9.3 
e opens. Click the 'X' to close this 
 the RightFax Installation Database.
itional Requirement
o use the RightFax integration with iNotes, all client workstations 
ust have the Java Virtual Machine available from Sun 
icrosystems.

figure the Notes E-mail Gateway and RightFax Server
. On the RightFax server or remote E-mail Gateway server, open 

the Windows Control Panel and double-click the RightFax 
E-mail Gateway applet. The E-mail Gateway configuration 
opens (fig 1.1).

. If you are upgrading from a previous RightFax integration with 
Notes, skip this step and continue to step 3. If you are 
performing a new install, you must first add the Notes E-mail 
Gateway. To add a new gateway, click Add Gateway. Select 
Lotus Notes from the list of gateway choices and click Select. 
Click the Notes gateway in the left pane list to view its 
configuration options. Next, in the Notes account password 
field, enter the password for the User.ID file that will be used by 
the Lotus Notes client to install the RightFax database files, and 
subsequently by the gateway to communicate with Domino. 

. If Include fax with notifications. If checked, notifications of 
successfully sent faxes or notifications of faxes that failed to 
send will include a viewable copy of the fax. Once enabled, 
select TIF or PDF format. Choose First Page if you want only 
the first page of the fax to be included with the notification. 
Choose All Pages if you want the full fax to be included. When 
finished, click OK..

. Open the \RightFax\Gateway folder and copy the RightFax 
database installer (RFINSTALL.NSF) to the Notes client 
computer that will be used to install the RightFax database files.

. Open Enterprise Fax Manager and in the left pane, click your fax 
server name. RightFax services are now viewable on the lower 
right side of Enterprise Fax Manager. In the list of running 
services, right-click the RightFax E-mail Gateway and choose 

Stop Service.

Figure 2.1  The E-mail Config

TipWhen you install the first
RightFax E-mail Gateway Mo
“Manual” and is started and s
can start and stop the RightF
Enterprise Fax Manager.

Installing the Notes Data
1. If you are upgrading, an

folder containing the Ri
location is on the Domi

2. Open a Notes client an
configure the e-mail ga

3. From the Notes client, c
Database > Open (R8 
Click the browse button
Double-click the file RF
Installation Database fil
window and proceed to
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tion will use a full mail integration and would like 
mail template using the Load Convert command 
rver, enter the required information and click 
ished, click Next to proceed to Step 6.  If your 
l not use a full mail integration, click Skip to 
p 6. For more information about Load Convert 
 User Mail Files with Load Convert”.

No to add Workspace shortcuts to the newly 
ax database files. Click Close to finish the 

es E-mail Gateway.Click Done, and then close 
o return to the workspace.

il Files with Load Convert
elow to incorporate RightFax design elements 
using Load Convert from a Domino console. For 
bout Load Convert, contact your Domino 

ail file for all Lotus users, logon to a Domino 
pe:  
ail/*.nsf * RightFax/rfaxmail.nsf and press 

ividual user mail files, logon to a Domino 
pe:  
ail/<user ID>.nsf * RightFax/rfaxmail.nsf  

r. 

complete when the Load Convert Utility 
ars. 

mino console and return to the Notes client 
4. Review the comments at the Welcome screen. When finished, 
click Start. The first of several Execution Security Alerts you will 
receive during the installation will appear. Enable the option to 
Start trusting the signer to execute this action and click OK. 
Do this for all remaining Security Alerts you receive during the 
installation. At the Step 1 window, click Next.

5. The installer will detect files from a previous RightFax 
integration. When RightFax files are found, the installer defines 
your setup as an Upgrade. If you are upgrading from a previous 
RightFax integration, verify the upgrade option is chosen, the 
setup options are correct, and click Next to proceed with the 
upgrade and continue to Step 3. 
 
If you are not upgrading, use the pick-list button to browse to 
the Domino server to install RightFax components to. You may 
also enter this information manually. The default location is 
\Domino\Data\RightFax. If you do not wish to install to 
\Domino\Data\RightFax, you must add the following entry to the 
Notes section of the Notes.ini file on the fax server or e-mail 
gateway server: RF_Syncdatabase=Fax\RFAXSYNC.nsf.  
 
For more information about Notes.ini, contact your Lotus 
administrator. Click Next to proceed to Step 3. 

6. On the Configure fax rendering document, specify one or both 
of the fax rendering options and associated foreign domain. 
Click Next to proceed to Step 4.

7. Choose Yes if you have explicit permission to Create new 
databases & templates and Create new replicas. If you do 
not have explicit permission, but belong to a group with these 
permissions, choose No and enter the group name or browse to 
the group using the pick-list. For more information about these 
permissions, contact your Lotus administrator. Click Start to 
begin copying RightFax database files to your Domino server. 
When finished, click Next to proceed to Step 5.

8. If your organiza
to update your 
on a Domino se
Start. When fin
organization wil
proceed to Ste
see “To Update

9. Choose Yes or 
installed RightF
install.

10.Restart the Not
the dialog box t

To Update User Ma
Follow the steps b
into user mail files 
more information a
administrator.

1. To update the m
console, and ty
load convert m
Enter.  
 
or to update ind
console, and ty
load convert m
and press Ente

2. The process is 
Shutdown appe

3. Minimize the Do
workspace.
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domains
ed with RightFax in Lotus Notes using 
ethods:

ntents of the Body field on the Notes 
dy of the Notes mail memo)
nd the Notes form itself
a fax, the fax domain name included in 
plicitly defines the RightFax mail router 
 the fax and transfer it to a RightFax 
ch mail router database is limited to 
from Notes in only one of the two 
mail router database associated with the 

ODY.NSF) is configured to process 
dy field. The RightFax Mail Router 

ORM.NSF) is used when sending faxes 
.

ain document in the Public Name 
e Domino server

rator, open the Public Name and 
k the Configuration tab.

 twisty, then click the Domains view.

he action bar.

 name field, enter the name of the new 
pically RFAX (for sending body contents 
r sending body contents and Notes 

ion tab. In the Gateway server name 
hed name of the Notes mail server 

us Notes Module is installed (e.g., 
eway mail file name field enter the path 
ase (e.g., RightFax\RFAXBODY.NSF or 
RM.NSF.).
ting the RightFax Database Files to Prepare 
nual Installation
omplete the following steps if you prefer or are required to install 

he RightFax database files manually. 

ote  Upgrades and creation of full-mail integration templates are not 
ossible using a manual installation.

. Configure the Notes Gateway and RightFax server using the 
instructions on page 11.

. Open a Notes client and logon with the Notes ID used to 
configure the e-mail gateway.

. From the Notes client, click the File menu and choose 
Database > Open (R8 clients use File > Application > Open).  
Click the browse button to locate the \RightFax\Gateway folder. 
Double-click the file RFINSTAL.NSF. The About RightFax 9.3 
Installation Database file opens. Click the 'X' to close this 
window and proceed to the RightFax Installation Database.

. Review the comments at the Welcome screen. When finished, 
click Start. The first of several Execution Security Alerts you will 
receive during the installation will appear. Enable the option to 
Start trusting the signer to execute this action and click OK. 
Do this for all remaining Security Alerts you receive during the 
installation. At the Step 1 window, click Next.

. Place a checkmark in the box next to Manual Installation.

. Specify a temporary folder to extract the database files to. This 
folder must be relative to the local \Lotus\Notes\Data folder. 
When finished, click Next.

. To begin extracting the database files, click Start. This process 
will perform a Notes copy of the database files, which inherently 
signs and registers each file. When finished, click Next.

. At step 4 click Close.

Create RightFax foreign 
You can render faxes creat
one of the following two m

z Incorporating only the co
form (that is, only the bo

z Including the body text a
When a Notes user sends 
the destination address im
database that will process
server for transmission. Ea
rendering outbound faxes 
methods listed above. The 
default  fax domain (RFAXB
only the contents of the Bo
(Forms) database (RFAXF
that include the Notes form

To create a foreign dom
and Address Book on th

1. Using Domino Administ
Address Book, then clic

2. Expand the Messaging

3. Click Add Domain on t

4. In the Foreign domain
domain. This name is ty
only) or RFAXFORM (fo
form).

5. Click the Mail Informat
field enter the distinguis
where the RightFax Lot
Server/Org). In the Gat
to the mail router datab
e.g., RightFax\RFAXFO
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U

ta Sharing with Lotus Notes
ring in a Lotus environment requires the 

x server can perform Lotus client print 

m Notes to RightFax while using multiple EFM 
 requires each EFM Sync to be configured for 

rom RightFax to Notes, only one EFM Sync can 

EFM Sync to use the RightFax shared data 

M Sync database using a Notes ID with 
 Access.

, under the Servers view, click RightFax 

e, click your fax server name.

ar click Edit RightFax Server. The RightFax 
t opens.

 next to Fax Server Directories.

 paths to reflect the RightFax shared data 

s for each EFM Sync database in your 

� � �
6. When finished, click Save and Close.

To complete the installation, continue to chapter 3, “Configuring 
the EFM Sync Database”.

ninstalling the Notes Module
1. On the RightFax server, open the Windows Control Panel and 

double-click the RightFax E-mail Gateway. The E-mail 
Configuration dialog box opens.

2. Select the Notes gateway to remove, and click Delete 
Gateway.

3. When finished, click OK.

To remove RightFax design elements from a user mail file

1. Open the EFM Sync database.

2. In the left pane of the EFM Sync, click Users\By Name.

3. In the right pane, click the name of the user or users whose mail 
file you wish to modify. 

4. Press delete on your keyboard. This will send the user a new 
RightFax user options document. Upon reciept, the user must 
open the message entitled RightFax User Options and click the 
Update RightFax button.  When finished, the user must close 
and re-open thier mail file.

Using RightFax Da
RightFax Data Sha
following:

z Only one RightFa
processing.

z Synchronizing fro
Sync databases,
data sharing.

z If synchronizing f
synchronize.

Configuring the 
folders

1. Log in to the EF
Administrative

2. On the left pane
Servers. 

3. On the right sid

4. On the action b
server documen

5. Click the twisty

6. Edit each of the
folders.

Repeat these step
organization. 
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 RightFax database files (described in 
otus Notes Module”), you configure the 
et your needs. You should complete the 

ess to EFM Sync (described on 

ion (described on page 17).

roups. (described on page 17).

ers from the Notes address book and 
ettings, e.g., User Templates (described 

es (described on page 19).

 server document establishing database 
n the RightFax and the Domino servers 
).

 gateway document (described on 

ver objects, such as cover sheets and 
 on page 29).
er 3

figuring the EFM Sync Database

hen the Notes module is first installed, the RightFax database is 
eplicated on the Domino server. This mirrored database, known as 
EFM Sync,” lets Notes administrators access and modify RightFax 
ettings from Notes. Database synchronization periodically updates 
he RightFax or Domino server with the data and configurations 
rom the other.

FM Sync contains the following information:

RightFax server and synchronization information
RightFax e-mail gateway information
RightFax users and groups, billing codes, cover sheets, overlay 
forms, and library documents.
Printers
Status reports of the RightFax server and the e-mail gateway
Logs of sent and received faxes processed on the RightFax 
server and more.

he interprocess communication document (ICD) is a small 
ocument that is generated when any of the module’s 
on-demand” functions are activated. The ICD is delivered to the 
ightFax ICD Router database, where the module collects it. The 
odule performs immediate action to fulfill the instructions 
ontained in the ICD. For example, ICD processing allows 

mmediate, on demand database synchronization.

After you have installed the
Chapter 2, “Installing the L
EFM Sync database to me
following basic steps:

1. Verify that you have acc
page 16).

2. Configure your integrat

3. Add or configure user g

4. Add users or import us
configure default user s
on page 17).

5. Create user routing cod

6. Configure the RightFax
synchronization betwee
(described on page 16

7. Configure the RightFax
page 23).

8. Configure RightFax ser
billing codes (described
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U e replication
abase can be configured for full or selective 
lication maintains a mirrored replica of the 
o or more servers. Selective replication is most 

tain a local replica of the database, such as on a 

n limits the amount of disk space required for 
the replication sessions can be kept short. A 
n is smaller because it excludes log documents.

abase is installed with full database replication, 
e selective replication.

ive database replication

the EFM Sync.

ion from the File menu, then New Replica. The 
 dialog box opens.

 Settings and click More Settings.

ver, and select the check box for Documents 
lection formula.
nderstanding EFM Sync Database Security
When a user with fax administrative rights exists in EFM Sync, it 
overrides the Access Control Lists (ACLs). Thus, if you are going to 
synchronize from RightFax to Lotus Notes, you must update the 
Connections document and Default User first, and then the Fax 
Server document. If you don't perform these tasks in this order, you 
can lock yourself out if the user is not an administrator on the 
RightFax server.

When the RightFax module is installed, you are prompted for the 
user or group to have administrative rights. This user/group is put in 
ACLs associated with all of the module's Lotus Notes databases. 
This group maintains Manager access over all databases. Although 
the group's name is defined during the installation process, 
qualified RightFax administrators can rename it if the need arises.

During the initial module installation, the person logged on to Notes 
for the installation is assigned Notes Manager access rights to 
EFM Sync. This person must log on in order to complete the 
installation or to assign Manager access to other users.

RightFax administrators can only make changes to the EFM Sync 
database.

During the module installation (described in Chapter 2, “Installing 
the Lotus Notes Module”), a RightFax administrative group is 
created in the Notes Public Address Book. Any Notes users in the 
RightFax administrative group can grant or deny access to other 
users. Add or remove Notes users to this group to grant or deny 
access to EFM Sync. Members of this group must have Notes 
Manager access rights to EFM Sync.

To make changes to the EFM Sync database, members of this 
group must also be assigned administrative rights in RightFax. To 
create RightFax administrators, see “Creating RightFax 
administrators” on page 19.

Managing databas
The EFM Sync dat
replication. Full rep
database across tw
often used to main
laptop.

Selective replicatio
the database, and 
selective replicatio

The EFM Sync dat
and you can enabl

To enable select

1. In Notes, open 

2. Select Replicat
Create Replica

3. Expand Replica

4. Click Space Sa
that meet a se
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tion:

tabase.

FM Sync, click Connections.

k New Connection. The New 
opens.

on document. When finished, click Save 

oups
ent regulate default fax options and 
 for fax user groups. These groups are 
 server and populated with fax users by 
 

cument

 pane of the EFM Sync database 

ent you want to edit and click Edit User 
tion bar. Alternatively, you may create a 
ew User Group.

er Group settings, please refer to Admin 

 Users
ightFax with your Notes system, you 
 Sync database.

click the EFM Sync icon to open the 
. In the formula window create the following formula:

SELECT @IsUnavailable ( Form ) | ( @IsAvailable ( Form) & 
Form != “Send Event” : “Receive Event” : “Sync Event” )

Figure 3.1  EFM Sync Replication Settings (Notes 6.x)

This formula excludes all log documents from replication. You 
can specify the documents you want to exclude from the 
replication.

. Click OK to save the settings.

uring your RightFax Integration
fter installing the RightFax database files, you must configure your 
ser integration with Notes. By default, RightFax ships with four 

ntegration profiles (called connections), each named according to 
he integration type it serves. Defining an integration is done on a 
er user basis under the Integration section of the User Options 
ocument, thus allowing multiple mail integrations in a single 
nvironment. 

To create a new connec

1. Open the EFM Sync da

2. In the left pane of the E

3. On the actions bar, clic
Connection document 

4. Configure the connecti
and Close.

Configuring fax user gr
The settings in this docum
required fax server settings
normally defined on the fax
the RightFax administrator.

To edit a User Group do

1. Click Groups in the left
window.

2. Select the group docum
Group on the Notes ac
new group by clicking N

For a description of the Us
help database.

Adding and Configuring
During the initial setup of R
must add users to the EFM

To begin in Notes, double-
EFM Sync database.
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template

e-click the EFM Sync icon. The EFM Sync 

plates view, click the New User Template 
he RightFax User Options document opens.

f the User Options settings, please refer to the 
se.

om the Names and Address 

RightFax databases, you can import users into 
base from the Domino Names and Address 
importing NAB users, you can synchronize them 
atabase. Supported synchronization methods 

 RightFax and synchronize from RightFax to 

 the EFM Sync database and synchronize from 
htFax.

from the NAB

rkspace, open the EFM Sync database.

he left side of the database window, under the 
 folder, click Users\By Name.

ar, click the down arrow next to Import Users 
select Import Users. The Select Population 
 opens.

selection box for the Populate from NAB 
l. Select the Domino Directory address book for 
n and click OK.
Configuring User Templates
You can use the RightFax User Options document to configure 
RightFax users in the EFM Sync database.

The RightFax administrator establishes a default user template by 
entering data in the Default User Options document. Subsequently, 
each new user document is created with these values and can be 
customized later as needed.

When the administrator creates a user,  a User Options document 
is placed into the user's Notes mail database, and the personal 
settings in the document are linked to the user's settings in the 
RightFax EFM Sync database. Security settings may permit the 
user to change some of these settings locally. When the user 
makes such changes, the EFM Sync database is updated 
automatically.

This document provides settings for the following fax features:

z Security
z Fax User identification
z Integration
z Personal Fax Preferences (including name and address book 

settings, fax icons, and how to convert attached files to fax 
format)

z Cover Sheet
z Billing Codes
z Fax Send Options
z Fax Receive Options
z Notification
z Inbound Routing
z Auto-Printing
z Pager Notifications
z Administrator Paging alerts (applies only to users with 

administrative permissions)
z Status

To create a user 

1. In Notes, doubl
opens.

2. In the User Tem
action button. T

For a description o
admin help databa

Importing users fr
Book

After installing the 
the EFM Sync data
Book (NAB). After 
into the RightFax d
are listed below:

z Maintain users in
EFM Sync.

z Maintain users in
EFM Sync to Rig

To import users 

1. In the Notes wo

2. In the pane on t
User Integration

3. On the action b
from NAB and 
Options window

4. Drop down the 
selection contro
your organizatio
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rant or deny access to other users. Add 
his group to grant or deny access to 
is group must have Notes Manager 
.

M Sync database, members of this 
ed administrative rights in RightFax. You 
the RightFax administration utility, 
 in EFM Sync. If you are synchronizing 
uld create administrators in Enterprise 

inistrators in Notes

he EFM Sync icon.The EFM Sync 

pen the user who should be a RightFax 
curity, select User has fax 

r document.

he EFM Sync database by importing 
ss book does not copy or create Direct 
led Number Identification Service 

or the new users. You can use the 
 the EFM Sync to generate these codes 

NIS fax routing codes for your users, be 
ild methods available and plan to use the 
r fax routing scheme. The following three 
. Under Other Options, select Run silent if you want to import 
users without being prompted for confirmation. This option is 
helpful for importing a large number of users, because you can 
leave the system unattended during the import process.

. Select one of the following options:

z Prompt for overwrite of existing entries. If a duplicate entry 
is found, you will have the option to delete or retain the 
original entry.

z Automatically overwrite existing entries. If a duplicate 
entry is found, the original entry will be deleted.

z Do not overwrite existing entries. If a duplicate entry is 
found, the original entry will be retained.

. 8.Click OK to import the users. Click Update RightFax  to finish 
configuring their workstations and accounts. All users must 
open and update the Connections document to install RightFax 
database files on their computers.

hen you import users from the NAB, RightFax automatically mails 
he user options document to those users. Thus, it is recommended 
hat you import only those groups of users whom possess the 
ame RightFax integration type (full mail, minimal mail, or no mail). 
n addtion, all users configured for either a full mail or minimal mail 
ntegration must open and update the user options document to 
nable RightFax design elements. 

ote  Users that fail to import are added to the list of imported users and 
re marked by a failed icon. To remove the failed icon, select users with a 
ailed icon, and click the Clear failed icon for user(s) button located on 
he action bar.

ating RightFax administrators
hanges to the EFM Sync database can be made only by RightFax 
dministrators.

uring the gateway installation (described in Chapter 2, “Installing 
he Lotus Notes Module”), you are prompted for the user or group 
o have administrative rights. Any Notes users in the RightFax 

administrative group can g
or remove Notes users to t
EFM Sync. Members of th
access rights to EFM Sync

To make changes to the EF
group must also be assign
can assign these rights in 
Enterprise Fax Manager, or
RightFax to Notes, you sho
Fax Manager.

To create RightFax adm

1. In Notes, double-click t
opens. 

2. Click a user view and o
administrator. Under Se
administrative rights.

3. Save and close the use

Creating routing codes
Creating new fax users in t
them from the Notes addre
Inward Dialing (DID) or Dia
(DNIS) fax routing codes f
DID/DNIS building tools in
automatically.

Before you create DID or D
sure to review the three bu
method that best suits you
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users, click to the left of the users for whom you 
routing codes. A check mark appears next to 

ar, click the down arrow on the Import Users 
tton and select Create DID/DNIS for Selected 

he next step, make sure the Do not overwrite 
IS entries check box is selected unless you want to 
g DID and DNIS routing code information on record 
or the selected users.

ing, Extraction, and Sequential tabs in the Build 
og box, and select the most appropriate build 
routing codes in your organization.

g tab to add any digits that are common to all 
uting codes in the organization, as needed.

 from the Build DID/DNIS dialog.

otes mail template
d the full Notes Mail integration with RightFax, 
 the RightFax mail template design to all Notes 

mail databases will be refreshed with the 
late design.

sign

rompt in the Domino server console window, 
” and press ENTER. Depending on the number 
, the process may take several minutes. The 

te when the prompt Database Designer 
s.
methods are available:

z The trimming method converts individual users' fax numbers in 
the RightFax database into unique routing codes. After removing 
any non-numeric characters (such as hyphens, parentheses, and 
spaces) in the fax numbers, this method defines each user's 
routing code as the first or last few digits in that user's fax 
number. You can select whether first or last digits are used and 
specify a number of those digits (from two to seven) to be saved 
as the code. The trimming method is useful for an organization 
that has a range of contiguous DID numbers to use as incoming 
fax lines, but it requires that all users' fax numbers have the same 
number of digits in the same positions.

z The extraction method retrieves specified digits from each user's 
fax number according to a mask (called a formula) that the 
administrator defines. The formula is formatted exactly as the 
users' fax numbers are, including non-numeric characters. One 
designated letter signifies a digit that must be retrieved as part of 
the routing code. All other characters must match a user's fax 
number for a code to be created for that user. The designated 
letter is N by default, but an administrator can change it if 
necessary. This method is useful where the DID or DNIS 
numbers are not necessarily contiguous; however, it does require 
that all fax numbers be as identical as possible in form, so that a 
few formulas can retrieve codes for all of the users.

z The sequential method generates new fax routing codes within 
parameters that the administrator specifies. Because it ignores 
the users' previously defined fax numbers completely, this 
method is especially useful for users who have not yet been 
assigned fax numbers.

To create DID/DNIS fax routing codes for one or more new 
fax users

1. In the Notes workspace, open the EFM Sync database.

2. In the pane at the left side of the database window, click 
Users\By Name.

3. In the list of fax 
want to create 
each user.

4. On the action b
from NAB ... bu
Fax Users.

Important   In t
existing DID/DN
replace all existin
in the database f

5. Using the Trimm
DID/DNIS dial
method for the 

6. Use the Paddin
DID or DNIS ro

7. Click OK to exit

Refreshing users’ N
If you have installe
you must distribute
mail users. Users’ 
RightFax mail temp

To update the de

At the command p
type “Load Design
of Notes mail users
process is comple
Shutdown appear
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ronization
otus Notes Module, all database 
. Only Notes users with Manager 
atabase can enable or disable 

t you enable synchronization after you: 

bjects that you will maintain in RightFax 
s users and billing codes).

tFax or in EFM Sync.

ization path for each object (from 
 or from EFM Sync to RightFax.

 document

ouble-click the EFM Sync icon. The 

ick the RightFax Servers view. On the 
tFax servers appears.

lowed by Edit RightFax Server on the 

er name and version appear.

ion 

ing

ct the check box to enable 
hronization.

r the frequency you want synchronization 
een the Domino and RightFax servers to 
r. A setting of eight hours is 
mmended.
uring the RightFax Server
hen you install the RightFax database files, server information is 

pecified in the Fax Server document in the EFM Sync database.

erstanding database synchronization
he RightFax Lotus Notes Module synchronizes the Notes and 
ightFax databases. Database synchronization periodically 
pdates either the RightFax or the Domino server with the 
atabase configuration from the other.

ynchronization is one directional: RightFax-to-Notes or 
otes-to-RightFax. During synchronization, new documents and 
hanges to existing documents are copied from the source server 
o the destination server, but data is never copied back from the 
estination server to the source server.

arning  After synchronization is set up, modifications to RightFax 
atabase settings should be made on the source database only (the 
atabase on the Domino server, by default). Changes made on the 
estination server will be overwritten the next time synchronization 
ccurs.

ecause a large part of the database consists of logs of gateway 
erver operations, you can control the size of the database by 
anaging the logs. You can:

Limit the amount of information recorded in the logs.
Limit the number of log documents to save.
Limit the age of log documents to save.

ou also can increase the size limit of the database. To manage the 
og documents, refer to the topics on managing logs in the online 
elp for RightFax administrators in Notes.

Enabling database synch
When you first install the L
synchronization is disabled
access to the EFM Sync d
synchronization.

RightFax recommends tha

1. Evaluate the database o
or in EFM Sync (such a

2. Define the data in Righ

3. Determine the synchron
RightFax to EFM Sync,

To configure the server

1. On Notes workspace, d
EFM Sync opens. 

2. Expand Servers and cl
right, a list of your Righ

3. Click a listed server, fol
action bar.

4. Under Basics, the serv

Table 3a  Fax Server Informat

Field Sett

Synchronization Sele
sync

Synchronization 
Interval

Ente
betw
occu
reco
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cts to Synchronize, enable each RightFax 
want to synchronize. For each object enabled, 
hronization method: RightFax to Notes or Notes 
te that Pager Services is a one-way 
 that provides the list of pager services available 
cations and Administrator Paging settings.

ers to Synchronize, specify the RightFax 
h you want to synchronize each RightFax object. 

iles to Synchronize, specify whether you want 
he library document, cover sheet, and fax form 
dition to the object IDs. This will copy the library 
r sheet, or fax form files from the RightFax server 
erver during synchronization. If you select either 
, you must also specify a folder on the Domino 
to store the files.

er Directories, paths and data folders on the 
 appear.

nts, enter any comments you may need as 

g Select the check box to enable writing fax 
server status documents in the EFM Sync 
database.

The amount of time between the end of one 
status monitoring cycle and the beginning of 
the next.

The status monitoring feature continually 
overwrites one status document. This means 
that you can set a very short interval without 
risk of the database size reaching its quota. 
The recommended setting is 60 seconds.

 Information (Continued)

Setting
5. Under Fax Obje
object that you 
specify the sync
to RightFax. No
synchronization
for Pager Notifi

6. Under Fax Serv
servers to whic

7. Under Image F
to synchronize t
image files in ad
document, cove
to the Domino s
of these options
server in which 

8. Under Fax Serv
RightFax server

9. Under Comme
documentation.

Synchronization 
Logging

Specify the level of information that will be 
written to the Synchronization Log:

None. Records the date and time of the 
synchronization and the result.

Terse (recommended). Records the success 
or failure of the synchronization process.

Normal. Records details that make it useful to 
the average RightFax user.

Verbose. Records details that make it useful 
to the RightFax administrator.

Debug. Records all details. This option 
dramatically increases the size of the EFM 
Sync database. Select this option if you are 
initially testing the synchronization, if you are 
experiencing synchronization failures, or if you 
require details significant to a RightFax 
customer support engineer.

For a description of the log, see “RightFax 
Event Logs” on page 45.

Synchronization 
Prescan Agent

The name of any Lotus Notes agent that 
should run prior to the synchronization.

Synchronization 
Postscan Agent

The name of any Lotus Notes agent that 
should run following the synchronization.

The default is “Initialize User Notes ID from 
User Name.” This assures that new fax users 
added to the EFM Sync database from 
RightFax are given Notes IDs in their fax user 
documents. The IDs are based on the User 
Name field in the fax user document, e.g., 
John Smith = JOHN_SMITH.

Table 3a  Fax Server Information (Continued)

Field Setting

Status Monitorin

Status Interval

Table 3a  Fax Server

Field
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ateway processes, the ICD process has 
it completes its last task and when it 
base for new ICD messages. For 
tion such as Process Outbound causes 
the following example.

r ICD processing is 45 seconds and the 
ound faxes is one minute.

 Outbound from within the Gateway 
ync database.

tion Process: Outbound is created in the 
ript.

e ICD Router database.

ing interval clock has counted down to 0, 
ICD Router database.

CD.

 the ICD by scanning the RightFax Mail 
tbound documents.

re delivered out of Domino to the 

ssing interval is reset to one minute and 
to 0.

erval clock is reset to 45 seconds and 
to 0.

otential lag of up to 45 seconds 
 Process Outbound action is invoked 
 is read and outbound faxes are 
, it is recommended that you configure 
f interval. Since ICDs are routed to a 
ular fax traffic, the ICD processing task 

 to complete when the ICD router is 
re ICD processing for a shorter interval 
0.Click Save and Close to save your synchronization settings and 
return to the EFM Sync database.

uring the RightFax Gateway Document
he RightFax e-mail gateway for Lotus Notes monitors the RightFax 
ail router database for outgoing faxes and interprocessing 
ommunication documents (known as “ICD documents”). In return, 
he RightFax mail router monitors the Notes mail server for faxes 
nd ICD documents.

CD processing allows immediate, on-demand database 
ynchronization.

erstanding ICD processing
he interprocess communication document (ICD) is a small 
ocument that is generated when any of the gateway “on-demand” 

unctions are activated. The ICD is delivered to the RightFax ICD 
outer database, where the gateway collects it. The gateway 
erforms immediate action to fulfill the instructions contained in the 

CD.

or example, the Process Outbound action in the gateway 
ocument will process outbound fax documents regularly 
ccording to the configured interval. However, there may be times 
hen it is crucial that the outbound faxes collected in the RightFax 
ail Router database be processed as quickly as possible. 

nvoking the Process Outbound action composes an ICD with 
nstructions commanding the gateway to process all outbound 
axes. The ICD is delivered to the RightFax ICD Router database 
ia Domino mail. The gateway collects the ICD, reads the 
nstruction, and runs the outbound processes. Finally, the gateway 
esets the interval clock so that outbound documents will be 
rocessed next at the end of the configured interval.

Be aware that, as with all g
an interval between when 
scans the ICD Router data
example, an on-demand ac
the sequence of events in 

Assume that the interval fo
interval for processing outb

1. A user selects Process
document in the EFM S

2. An ICD with the instruc
background by LotusSc

3. The ICD is mailed to th

4. When the ICD process
the gateway scans the 

5. The gateway finds the I

6. The gateway processes
Router database for ou

7. Any documents found a
RightFax server.

8. The outbound fax proce
begins counting down 

9. The ICD processing int
begins counting down 

In this example there is a p
between the time when the
and the time when the ICD
processed. For this reason
ICD processing with a brie
different database from reg
can require almost no time
empty, so you can configu
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 Inbound Faxes, specify the following settings.

Specify the level of status information that will 
be written to the ICD router database.

z None. Records the date and time the fax was 
submitted.

z Terse (recommended). Records the success 
or failure of the delivery of the ICD.

z Normal. Records details that make it useful to 
the average RightFax user.

z Verbose. Records details that make it useful 
to the RightFax administrator.

z Debug. Records all details. This option 
dramatically increases the size of the EFM 
Sync database.

The ICD status can be monitored in the ICD 
router database messages view.

Select the Notes mail server where ICD 
documents are routed.

Select the file name where the ICD router 
database is located (usually in the Notes Mail 
database.)

r Inbound Faxes 

Setting

Select the check box to receive inbound faxes.

Enter the interval at which the gateway should 
check the RightFax server for inbound faxes.

r ICD Processing (Continued)

Setting
than you might for other intensive fax processes. Even a setting of 
15 seconds will not tax regular fax processes because for the 
majority of time the ICD router database will be empty..

To configure the gateway document

1. In Notes, double-click the EFM Sync icon. This opens the EFM 
Sync view. Open the Gateway view. A list of your RightFax 
e-mail gateways appears in the view.

2. Double-click a listed gateway to open the Gateway document. 
Click Edit Gateway.

3. Under Basics, information about the e-mail gateway is provided 
by the gateway.

4. Under Interprocess Communication Document Processing, 
specify the following settings,

5. Under Receive

Table 3b  Settings for ICD Processing 

Field Setting

Enabled Select the check box to activate interprocess 
communication document (ICD) processing.

Interval Enter the interval at which the gateway should 
monitor the ICD router database. A setting of 
15 seconds is recommended.

Logging

Notes Mail 
Server

Router 
Database

Table 3c  Settings fo

Field

Enabled

Interval

Table 3b  Settings fo

Field
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T

 fax is received, this text can be displayed 
ubject field of the Notes message that 
 the recipient. The notification message 
tain a combination of text and variables.

ault is “A new <FAX_NUMPAGES> page 
arrived from <FAX_CSID>”.

MPAGES = The number of pages 
received.

ID = The sender’s caller subscriber ID 
(CSID).

 fax is received, this text can be displayed 
ender field of the Notes message that 
 the recipient. The notification message 
tain a combination of text and variables.

ault is “Fax Server 
ERVERNAME>”.

RVERNAME = The name of the fax 

ification to the sender will include the 
 line of the sent fax.

der of the message containing an 
 fax can include data about the receipt, 
 the name of gateway and the receipt 

plate for this data can be an .rtf file or a 
orm.

d Faxes (Continued)
Logging Specify the level of information that will be 
written to the Fax Receive Log. 

z None. Records the date and time the fax was 
received and the result.

z Terse. (recommended). Records the success 
or failure of the received fax.

z Normal. Records details that make it useful to 
the average RightFax user.

z Verbose. Records details that make it useful to 
the RightFax administrator.

z Debug. Records all details. This option 
dramatically increases the size of the EFM 
Sync database. Select this option if you are 
initially testing the synchronization, if you are 
experiencing synchronization failures, or if you 
require details significant to a RightFax 
customer support engineer.

For a description of the log, see “RightFax Event 
Logs” on page 45.

Notes Mail 
Server

Select the Notes mail server where faxes should 
be sent.

Router 
Database

The name of Notes mail router database where 
the gateway sends faxes.

Prescan Agent The name of any Lotus Notes agent that you 
would like the gateway to run prior to each cycle 
of checking for received faxes in the mail router 
database.

Postscan Agent The name of any Lotus Notes agent that you 
would like the gateway to run immediately after 
each cycle of checking for received faxes in the 
mail router database.

able 3c  Settings for Inbound Faxes (Continued)

Field Setting

New Fax 
Subject Line

When a
in the s
notifies
can con

The def
fax has 

FAX_NU

FAX_CS

New Fax From 
Line

When a
in the s
notifies
can con

The def
<FAXS

FAXSE
server.

Include 
Original 
Subject in 
Completed Fax 
Notification

The not
subject

Source for Fax 
Header Image

The hea
inbound
such as
time.

The tem
Notes f

Table 3c  Settings for Inboun

Field Setting
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tbound Faxes, specify settings that affect 
. You can establish separate settings for:

d in Notes that captured only the contents of the 
ody field and ignored all other elements of the 
such as headers, graphics, and tables). 
d with the Notes form elements intact, capturing 
derlying Notes form (instead of the body only).

r Outbound Faxes 

Setting

Select the check box to send outbound faxes.

Enter the frequency you want the gateway to 
check the Notes mail server for outbound 
faxes. The recommended setting is 60 
seconds.

Specify the level of information that will be 
written to the Fax Send Log.

z None. Records the date and time the fax 
was sent and the result.

z Terse. (recommended). Records the 
success or failure of the sent fax.

z Normal. Records details that make it useful 
to the average RightFax user.

z Verbose. Records details that make it 
useful to the RightFax administrator.

z Debug. Records all details. This option 
dramatically increases the size of the EFM 
Sync database. Select this option if you are 
initially testing the synchronization, if you 
are experiencing synchronization failures, or 
if you require details significant to a 
RightFax customer support engineer.

For a description of the log, see “RightFax 
Event Logs” on page 45.
6. Under Send Ou
outbound faxes

z Faxes create
Notes form b
Notes form (

z Faxes create
the entire un

Process Fax 
Body

By default, received fax images are attached to 
Notes mail messages. To view the fax, the 
recipient must select the image and open it. You 
have the following options:

z To attach fax images, select Attach Fax 
Images.

z To embed the image in the message so that it 
can be viewed within the message without 
opening it, select Embed Fax Images.

z To embed and attach fax images, select Embed 
and Attach Fax Images.

Fax Images to 
Embed

z To embed the first page of the image in the mail 
message, such as the cover page, select First 
Page.

z To embed all the fax page images in the mail 
message, select All Pages.

Size of 
Embedded Fax 
Images

Select the proportionate size for fax images that 
will be embedded in Notes mail messages rather 
than attached.

Attach History To attach a text file that contains the transmission 
history to each received fax, select Yes.

Table 3c  Settings for Inbound Faxes (Continued)

Field Setting

Table 3d  Settings fo

Field

Enabled

Interval

Logging
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T

ing Notes Client Print Processing, this 
ing establishes a time limit for the Notes 
nt on the RightFax server to convert the 
es message to fax format. After this time 
, RightFax will close the Notes client. It 
umes that Notes is not working or is 
ting for user interaction that has not been 
ived.

ct the interval to run the Notes Client 
t Process.

ing Notes Client Print Processing, this 
ing determines when the Notes client will 
losed and opened to clean up Notes 
esses on the RightFax server.

ortant
es will stop processing printed fax forms 
n it is closed. Thus, in almost all 
umstances, especially with high volume, 
this option to Never. 

the same reason, do not manually close 
Notes client on the RightFax server. If the 
es client is closed, you will see the error, 
able to open Desktop File...”

nd Faxes (Continued)

ting
Notes Mail Server Select the Notes mail server where the 
gateway mail router database resides.

Router Database The name of the Lotus Notes mail router 
database where the named gateway sends 
faxes.

Prescan Agent The name of any Lotus Notes agent that you 
would like the gateway to run prior to each 
cycle of delivering faxes out of the mail router 
database.

Postscan Agent The name of any Lotus Notes agent that you 
would like the gateway to run immediately 
after each cycle of delivering faxes out of the 
mail router database.

Export Method If faxes will consist of the contents of the 
Notes body field only, select Microsoft Word 
RTF as the method of export.

If faxes will include the Notes form elements, 
select one of the following options:

z Notes Native Export. RightFax converts 
the message to fax format using the native 
Notes export process. The process runs in 
the background and does not use the 
Notes client. This option cannot be used 
with Notes 5.03 and 5.04.

z Notes Client Print Processing. On the 
RightFax server, the Notes client print 
process is used to convert a message to 
fax format. This process is slower than the 
native Notes export process.

Export Page Size Determines the page size for the fax. This 
option is not available for Notes Client Print 
Processing.

able 3d  Settings for Outbound Faxes (Continued)

Field Setting

Notes Client Print 
Timeout

If us
sett
clie
Not
limit
ass
wai
rece

Notes Client Print 
Throttle

Sele
Prin

Notes Client Print 
Cleanup

If us
sett
be c
proc

Imp
Not
whe
circ
set 

For 
the 
Not
“Un

Table 3d  Settings for Outbou

Field Set
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e Fax Status, you can activate real-time fax 
. You can establish separate settings for:

d in Notes that captured only the contents of the 
ody field and ignored all other elements of the 
such as headers, graphics, and tables). 
d with the Notes form elements intact, capturing 
derlying Notes form (instead of the body only).

r Real-Time Fax Status 

Setting

Select the check box to activate real-time fax 
status reporting.

Select Yes to include cover pages in the 
real-time fax status report. This will increase the 
size of the report and the EFM Sync database.

Select If Needed to append cover pages for:

z Faxes held for preview.
z Faxes that require approval.

Select Yes to include body pages of sent faxes 
in the real-time fax status report. This will 
increase the size of the report and the EFM 
Sync database.

Select If Needed to append cover pages for:

z Faxes held for preview.
z Faxes that require approval.
7. Under Real-Tim
status reporting

z Faxes create
Notes form b
Notes form (

z Faxes create
the entire un

Unknown 
Originator

Determines how to handle an outbound fax 
when the sender has no User Options 
document in the EFM Sync database:

z Do not send. Abandons the fax and sends 
a failure message to the sender.

z Send using default user. Retrieves 
settings and data from the default user 
document in the EFM Sync database.

z Create user record. Retrieves settings and 
data from the default user document in the 
EFM Sync database, and creates a new fax 
user record based on the defaults.

Delete Sent Faxes 
from Router

Select the check box to have the gateway 
delete the fax document from the mail router 
database after the fax is successfully sent.

Force Notification 
to Always

Select the check box to override the sender’s 
notification setting in the User Options 
document, thus always sending a notification 
for faxes sent through this gateway.

Table 3d  Settings for Outbound Faxes (Continued)

Field Setting

Table 3e  Settings fo

Field

Real-Time Fax 
Status

Append Cover 
Page to Log

Append Body 
Images to Log
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8

bjects in Notes
e RightFax database. If you are 

otes, you should configure the RightFax 
inistration utility, Enterprise Fax 

 Notes, double-click the EFM Sync icon 
abase. Double-click each of these 
nd edit the RightFax objects in the 

irror of the RightFax database, each of 
 the same settings that appear in 
r a description of the settings for these 
 appropriate chapter of the RightFax 

 Faxes
l Notes Mail integration with RightFax, 
 return undeliverable faxes to the 

x server and the server can’t deliver the 
ax failure notification. However, if a fax 
elivered to the RightFax server, the 
n of the failure. You can configure Notes 
s to the senders. To do this, you activate 
ail Router database.

T

. Under Outbound Conversion Defaults, specify document 
conversion defaults for Microsoft Excel, Microsoft PowerPoint, 
and Visio documents. The password you enter in the Password 
box will be used when RightFax attempts to open a 
password-protected file for server-side application conversion. 

Configuring RightFax O
EFM Sync is a mirror of th
synchronizing RightFax to N
objects in the RightFax adm
Manager.

To configure the objects in
to open the EFM Sync dat
documents to view, add, a
following sequence:

1. Cover sheets

2. Fax overlay forms

3. Fax printers

4. Billing codes

5. Library documents

6. Fax user groups

Because EFM Sync is a m
these documents includes
Enterprise Fax Manager. Fo
objects, please refer to the
Administrator’s Guide.

Handling Undeliverable
If you have installed the ful
you can configure Notes to
senders.

If a fax reaches the RightFa
fax, RightFax generates a f
sent from Notes can’t be d
sender won’t get notificatio
to return undeliverable faxe
an agent in the RightFax M

Append History 
to Log

Select Yes to include the history of each sent 
fax in the real-time fax status report. This will 
increase the size of the report and the EFM 
Sync database.

Delete 
Completed 
Faxes

You can specify whether or not to delete 
completed faxes from the real-time fax status 
report after the faxes are successfully sent.

z Select None to never delete faxes from the 
report.

z Select Successful Only to delete only faxes 
that are successfully sent.

z Select All to delete all faxes from the report.

able 3e  Settings for Real-Time Fax Status (Continued)

Field Setting
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For each undeliverable fax, the agent creates a “Fax Delivery 
Failure” report. The agent then mails the report to the fax sender so 
that the fax can be re-addressed and sent.

To configure the “Handle Undeliverable Faxes” agent

1. Open the RightFax Mail Router database.

2. In the Agents view, edit the agent Handle Undeliverable 
Faxes.

3. Change the value of When should this agent run from On 
Schedule Never to On Schedule <xxx>, where <xxx> is the 
interval at which you would like log maintenance to occur. For 
Notes version 5.0.11 and later, the recommended setting is “On 
Schedule More Than Once A Day.”

4. Click Schedule to further define the log maintenance interval. 
For Notes version 5.0.11 and later, the recommended setting is 
15 minutes or less. (Do not set the interval to 0 hours 0 minutes. 
This setting disables the agent.)

Schedule the agent so that fax senders will be notified of their 
undeliverable faxes within a reasonable interval.

5. Save and close the agent. This will re-sign the agent with your 
signature so that it will run within your organization.

6. In the Agents view, select the check box to the left of the 
Handle Undeliverable Faxes agent to enable it.

If this message appears: “Unable to determine the execution 
access privileges for this agent on <xxx>; agent may not run,” then 
you may not have the appropriate rights to execute the agent. Refer 
to the online help for administrators in Notes for more information 
on scheduled agents.

� � �
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Appen

E-m

E
d
c
d

T
y
b
i
e

<

R
w
I
R
w
w
c

A
m
T
f
a
t
f

by the information or instruction they 
odes are surrounded by angle brackets 
 the same native printer font.

 Captaris recommends using the “Courier” 

laced anywhere in the e-mail message 
y cannot line wrap and any embedded 
ong that it wraps to a second line will be 

bedded codes that are recognized by 
Fax supports several additional 
xes are generated from native 
te list of embedded codes supported by 
tFax Administrator’s Guide.

on a specific date. Dates can be 
solute. Relative dates give the number of 
r example, “+7” represents one week 
 specify the exact date to send the fax. 
ritten in one of these formats: 
r MM-DD-YYYY.
dix A

ail Compatible Embedded Codes

mbedded codes are special faxing instructions that you insert 
irectly into fax-bound e-mail messages. You can use embedded 
odes to include fax cover sheet information, attach library 
ocuments, specify a time to send the fax, and more.

o add an embedded code to an e-mail message, type the code 
ou want, along with any required parameters, between angle 
rackets. For example, an embedded code that tells RightFax to 

nclude the library document “Priceguide” along with the text of the 
-mail is written as:

LIBDOC2:PRICEGUIDE>

ightFax removes all embedded codes from the e-mail message 
hen it converts it to fax form, so they don’t appear in your final fax. 

f you type an embedded code incorrectly, it will be ignored by 
ightFax and will be included in your fax. Embedded codes may be 
ritten in either upper or lower case and embedded codes always 
ork the same way regardless of the e-mail application used to 
reate the document.

lthough you can use any fonts you want in the text of your e-mail 
essages, embedded codes must always use a native printer font. 
his is because when the file is converted to PCL5 format, all other 
ont types are encoded as graphic images. Only native printer fonts 
re stored in the PCL file in their original text format. It is this text in 
he PCL file that is replaced. If you do not use native printer fonts 
or your embedded codes, the codes themselves will appear in the 

instead of being replaced 
represent. All embedded c
(< >) which must also use

Note  For embedded codes,
native printer font only.

Embedded codes can be p
that you will be faxing. The
code statement that is so l
ignored.

This appendix lists only em
the e-mail gateways. Right
embedded codes when fa
applications. For a comple
RightFax, refer to the Righ

ATDATE
Format <ATDATE:date>

Schedules the fax to send 
expressed as relative or ab
days from today’s date. Fo
from today. Absolute dates
Absolute dates must be w
MM/DD/YY, MM-DD-YY, o
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de to the fax. The billing code will be sent but it 
d by RightFax.

th: 15 characters

FO1:4444>

FO2:code>

billing code to the fax. The billing code will be 
be validated by RightFax.

th: 15 characters

FO2:5555>

NEL:channel#>

 on the specified channel of the fax board. 
orresponding to the channel to use. Set the 

 0 (zero) to use any available channel.

 if your organization uses one channel for priority 
nt the fax to go out right away. You can also use 
x broadcasts to one channel only, leaving the 
 for priority faxing.

th: N/A

NEL:3>

R>

rates a RightFax cover sheet for the fax 
e. If the user sending the fax containing this 
 to automatically generate a cover sheet, only 
ill be generated.
If no send time is specified with the ATTIME code (described later), 
the send time defaults to “now” (the current time of processing). 
For example, if a fax is sent to the queue at 3:30 p.m. and it 
contains only an <ATDATE:+1> code, it will automatically be 
scheduled to send at 3:30 p.m. tomorrow.

Maximum field length: 10 characters

Example <ATDATE:9-15-99> 
<ATDATE:+2>

ATTIME
Format <ATTIME:time>

Schedules the fax to send at a specific time. The time can be 
relative or absolute.

Relative time is the number of hours or minutes from the current 
time. For example, “+2” is two hours from now. You can enter 
fractions of an hour in six-minute increments. Valid fractions of an 
hour are 0.1 through 0.9. You must enter at least one digit before 
and after the decimal point. For example, 1.5 and 0.3 are valid, and 
1.50 and .3 are not valid.

Absolute times are entered in either 12-hour or 24-hour format. A 
colon separating hours and minutes is optional, and an “a” or “p” 
can be used to indicate A.M. or P.M. The fax server does not send 
the fax at exactly the minute specified. Rather, the fax becomes 
eligible for scheduling within 15 minutes of the specified time.

Specifying a time between the current time and midnight will 
schedule the fax to send today. Specifying a time earlier than the 
current time will schedule the fax tomorrow.

Maximum field length: 9 characters

Example <ATTIME:10:00p> 
<ATTIME:+2>

BILLINFO1 (BI1)
Format <BILLINFO1:code>

Assigns a billing co
will not be validate

Maximum field leng

Example <BILLIN

BILLINFO2 (BI2)
Format <BILLIN

Assigns a second 
sent but it will not 

Maximum field leng

Example <BILLIN

CHANNEL
Format <CHAN

Sends the fax only
Specify a number c
channel number to

This code is useful
faxing, and you wa
this code to limit fa
other channels free

Maximum field leng

Example <CHAN

COVER
Format <COVE

Automatically gene
containing the cod
code is configured
one cover sheet w
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U
e
a

M

DEL
F

D
s
a

M

DEL
F

D
b
o

M

FCS
F

U
c
R
s

M

E

FIN
F

ax using “fine” resolution (200 × 200 
ommended for faxes with detailed 
ll be OCRed. This code overrides the 
 the user's FaxUtil mailbox.

M:faxnumber>

number on the RightFax-generated fax 
eet is generated by RightFax, this code 

haracters

M:(520)555-1234>

XNUM:faxnumber>

eneral fax number to be placed on the 
ver sheet. If no cover sheet is generated 
be ignored.

haracters

XNUM:(520)555-2345>

ONE:phonenumber>

eneral phone number to be placed on 
 cover sheet. If no cover sheet is 
s code will be ignored.

haracters

ONE:(520)555-3456>
nless a cover sheet file name is specified using the <FCSFILE> 
mbedded code (see “FCSFILE” on page 33), this code will 
utomatically use the default cover sheet file.

aximum field length: N/A

ETE
ormat <DELETE>

eletes the fax from the user’s FaxUtil mailbox after it has been 
uccessfully sent. This code overrides the default RightFax 
uto-delete setting.

aximum field length: N/A

ETEALL
ormat <DELETEALL>

eletes all faxes from the user’s FaxUtil mailbox after the fax has 
een sent, whether or not the send was successful. This code 
verrides the default RightFax auto-delete setting.

aximum field length: N/A

FILE
ormat <FCSFILE:file name>

ses the specified file as the RightFax-generated cover sheet. The 
over sheet file must exist in the RightFax\FCS folder on the 
ightFax server and must end with the extension .pcl. Do not 
pecify a directory path.

aximum field length: 12 characters

xample <FCSFILE:MYCOVER1.PCL>

E
ormat <FINE>

Converts the body of the f
DPI). Fine resolution is rec
graphics and faxes that wi
default fax resolution set in

Maximum field length: N/A

FROMFAXNUM
Format <FROMFAXNU

Specifies the sender’s fax 
cover sheet. If no cover sh
will be ignored.

Maximum field length: 31 c

Example <FROMFAXNU

FROMGENFAXNUM
Format <FROMGENFA

Specifies the company’s g
RightFax-generated fax co
by RightFax, this code will 

Maximum field length: 31 c

Example <FROMGENFA

FROMGENPHONE
Format <FROMGENPH

Specifies the company’s g
the RightFax-generated fax
generated by RightFax, thi

Maximum field length: 31 c

Example <FROMGENPH
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th: 21 characters

C2:INFOPACK1>

VER>

 RightFax cover sheet generation for the 
ng this code.

th: N/A

AL>

 of the fax using “normal” resolution (100 × 100 
ution faxes can be transmitted much faster than 
s, saving time and phone charges. This code 
lt fax resolution set in the user’s FaxUtil mailbox.

th: N/A

EW>

eview in your FaxUtil mailbox. You must view the 
elect Release from the File menu before it will 

th: N/A

ITY:priority>

 the outgoing fax. Allowed settings are: Low (L), 
igh (H). If a user specifies high priority and does 
use high priority” permission, the fax will 
nt with “normal” priority.
FROMPHONE
Format <FROMPHONE:phonenumber>

Specifies the sender’s phone number to be placed on the 
RightFax-generated fax cover sheet. If no cover sheet is generated 
by RightFax, this code will be ignored.

Maximum field length: 31 characters

Example <FROMPHONE:(520)555-4567>

IGNORE
Format <IGNORE>

Causes all subsequent embedded codes to be ignored.

Maximum field length: N/A

LIBDOC
Format <LIBDOC:documentID>

Sends the specified RightFax library document in addition to 
sending the document containing the code. Multiple library 
documents may be specified, each as a separate LIBDOC code. 
When used with e-mail gateways, this embedded code functions 
exactly the same as LIBDOC2.

Maximum field length: 21 characters

Example <LIBDOC:INFOPACK1>

LIBDOC2
Format <LIBDOC2:documentID>

Sends the specified RightFax library document in addition to 
sending the document containing the code. Multiple library 
documents may be specified, each as a separate LIBDOC2 code. 
When used with e-mail gateways, this embedded code functions 
exactly the same as LIBDOC.

Maximum field leng

Example <LIBDO

NOCOVER
Format <NOCO

Turns off automatic
document containi

Maximum field leng

NORMAL
Format <NORM

Converts the body
DPI). Normal resol
fine resolution faxe
overrides the defau

Maximum field leng

PREVIEW
Format <PREVI

Holds the fax for pr
fax in FaxUtil and s
send.

Maximum field leng

PRIORITY
Format <PRIOR

Sets the priority of
Normal (N), and H
not have the “Can 
automatically be se
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M

E

RET
F

S
e
a
s

M

E

RET
F

S
w
a

M

E

SAV
F

I
F
a

M

SM
F

E

 � �
aximum field length: N/A

xamples<PRIORITY:H> 
<PRIORITY:N>

RYCOUNT
ormat <RETRYCOUNT:#>

pecifies the number of times the fax will be retried after 
ncountering transmission errors (such as a busy signal or human 
nswered line). A value of 0 (zero) tells the fax server to use the 
ystem defaults.

aximum field length: 2 numeric digits

xample <RETRYCOUNT:3>

RYINTERVAL
ormat <RETRYINTERVAL:#>

pecifies the length of time in minutes between retry attempts 
hen transmission errors (such as a busy signal or human 
nswered line) are encountered.

aximum field length: 2 numeric digits

xample <RETRYINTERVAL:2>

E
ormat <SAVE>

nstructs RightFax to not delete the fax image from the user’s 
axUtil mailbox after being sent. This overrides any default 
uto-delete setting.

aximum field length: N/A

ARTRESUME
ormat <SMARTRESUME>

nables the Smart-resume feature.

Maximum field length: N/A

�
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Appen

File 

T
f
e
c
a

F attachments and Postscript requires the 

T

2000 through 2007

All versions

Versions through 8.0

All versions

t (see All versions

All versions

All versions

All versions

No specific version

No specific version

PG Versions through 2.0

nt File Formats (Continued)

at Supported versions
A

dix B

Formats that Convert to Fax Format

he following table lists the software applications and document 
ile formats that can be converted to faxes by the built-in conversion 
ngine on the RightFax server. Only these file types can be 
onverted from their native format by sending as file attachments to 
 fax message or by using the Send To function in Windows.

ImportantConversion of PD

able B1  Supported Document File Formats 

Application or file format Supported versions

ANSI text (7 & 8 bit) All versions

ASCII text (7 & 8 bit) All versions

BMP Windows versions

DCX (multi-page PCX) Microsoft Fax

EPS If TIFF image is embedded

GIF All versions

HTML Versions through 4.0

JPEG (includes EXIF) All versions

Microsoft Excel Versions 2000 through 2007

Microsoft PowerPoint Versions 2000 through 2007

Microsoft Rich Text Format 
(RTF)

All versions

Microsoft Visio (.VSD files) 2000 through 2007

Microsoft Word

Microsoft WordPad

Microsoft Works

PCX bitmap

Portable Document Forma
note below)

Post Script

TIFF CCITT Group 3 & 4

Unicode Text

UUEncode

UTF-8

WordPerfect Graphics (W
and WPG2)

Table B1  Supported Docume

Application or file form
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RightFax PDF Module.

� � �



39

A
agent

Handle Undeliverable Faxes 29
initialize user Notes ID 22

B
billing codes 29

C
Configure 11
configure

Lotus Notes Module 11
Notes and RightFax database 

synchronization 21
Notes ICD processing 24
real-time fax status report 28
receiving inbound faxes 24
sending faxes 26

Configure the Notes E-mail Gateway and
RightFax Server 11

Configuring fax user groups 17
Configuring your RightFax Integration 17
cover sheet 29
create

RightFax administrators 19
Creating routing codes 19

default user, adding 18
document conversion options 29

RETRYINTERVAL 35
SMARTRESUME 35

le
ull vs. selective replication 16

Notes and RightFax database 
synchronization 21

Notes ICD processing 24
receipt of inbound faxes 24
sending faxes 26

F
Fax Delivery Failure report 30
fax factory database 6
fax printers 29
faxes

file formats for conversion 37
faxes, undeliverable 29

G
gateway

extract databases for installation 13
installing manually 13
undeliverable faxes agent 29

gateway service
overview 5

Index
 

E
EFM Sync database

adding the default user 18
adding users 17
configuring 15
configuring synchronization 21
enabling ICD processing 24
enabling receipt of inbound faxes 24
enabling sending faxes 26
enabling synchronization with 

RightFax 21
full vs. selective replication 16
overview 15
security 16
synchronization 21

embedded codes
RETRYCOUNT 35
D
database synchronization, enabling 21

enab
f
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H
Handle U

I
ICD (inte

proces
inbound 
install

Note
Note

Installing
interproc

processing 6

L
library do

M
Microsoft
Microsoft

conver

N
New Inst
Notes

initia
No

Notes ag
Hand
initia

Notes an
Notes design, updating 20
Notes gateway

document conversion options 29
sync

elements as fax 26
sending message body as fax 26

overlay forms 29

T
To Update User Mail Files with Load 

Convert 12

U
undeliverable faxes 29
Uninstalling the Module 14
users

adding to EFM Sync database 17
Using RightFax Data Sharing with Lotus 

Notes 14

V
Visio document conversion 29
hronizing RightFax and Notes 
cuments 29

 Excel document conversion 29
 PowerPoint document 
sion 29

all Requirements 9

lize user Notes ID agent, initialize user 
tes ID agent 22
ent
le Undeliverable Faxes 29

lize user Notes ID 22
d RightFax integration options 5

R
real-time fax status report

configuring 28
RightFax administrators 19
RightFax document conversion 37
RightFax fax factory database 6

S
send

faxes using client print process 27
faxes using native export process 27

server-side application conversion options in 
Notes 29

synchronize
Notes and RightFax databases 21
ndeliverable Faxes agent 29

rprocess communication document) 
sing 6
faxing, configuring 24

s and RightFax integration options 5
s module manually 13
 the Notes Database Files 11
ess communication document (ICD) 

databases 21
Notes ICD processing 24
Notes Integration Options 5
Notes mail template, refreshing 20
Notes users

adding to EFM Sync database 17

O
outbound faxing

configuring 26
native export process 27
Notes client print process 27
sending message body and Notes form 
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